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ABSTRAK

ANALISIS KUALITAS AIR BERDASARKAN PARAMETER TOTAL
SUSPENDED SOLID DAN KLOROFIL-A MENGGUNAKAN CITRA
LANDSAT 8 DI BENDUNGAN WAY RAREM

Oleh:

VIONITA GUNAWAN

Pertumbuhan eceng gondok (FEichhornia crassipes) yang masif di
Bendungan Way Rarem, Lampung Utara, menjadi indikator adanya tekanan
ekologis yang berdampak pada penurunan kualitas air. Penelitian ini bertujuan
untuk menganalisis kondisi kualitas air melalui parameter Total Suspended Solid
(TSS) dan klorofil-a pada tahun 2025. Hal ini dilakukan guna memberikan
gambaran aktual mengenai kondisi kualitas air di Bendungan Way Rarem secara
menyeluruh sebagai dasar pengelolaan ekosistem yang berkelanjutan.

Penelitian ini memanfaatkan data utama berupa citra satelit Landsat 8 tahun
2025. Estimasi konsentrasi Total Suspended Solid (TSS) dilakukan melalui tiga
algoritma empiris yaitu Budiman, Laili, dan Parwati yang kemudian divalidasi
dengan data lapangan (/n-sifu), dimana akurasi model diukur menggunakan RMSE.
Sementara itu, konsentrasi klorofil-a diestimasi menggunakan algoritma berbasis
Normalized Difference Chlorophyll Index (NDCI). Hubungan korelasi antara TSS
dan klorofil-a diuji menggunakan metode statistik korelasi pearson.

Hasil penelitian pada tahun 2025 menunjukkan bahwa algoritma Budiman
merupakan model terbaik dalam mengestimasi TSS dengan nilai RMSE sebesar
1,571. Parameter TSS dalam penelitian ini berfungsi sebagai indikator material
tersuspensi yang membawa asupan nutrien bagi vegetasi air. Berdasarkan hasil
pemetaan klorofil-a menggunakan indeks NDCI, status kualitas air di Bendungan
Way Rarem didominasi oleh status Hipereutrofik (kesuburan tinggi) dan Mesotrof
(kesuburan sedang) yang terkonsentrasi pada wilayah dengan kerapatan eceng
gondok yang tinggi. Hasil uji korelasi Pearson menunjukkan adanya hubungan
positif antara parameter TSS dan klorofil-a dengan nilai koefisien korelasi sebesar
r = 0,556. Hubungan ini menunjukkan bahwa peningkatan konsentrasi material
tersuspensi di perairan berkontribusi terhadap meningkatnya kesuburan perairan
yang memicu pertumbuhan vegetasi air seperti eceng gondok di Bendungan Way
Rarem.

Kata Kunci: Kualitas air, Total Suspended Solid, Klorofil-a, Penginderaan jauh



ABSTRACT

ANALYSIS OF WATER QUALITY BASED ON TOTAL SUSPENDED
SOLID AND CHLOROPHYLL-A PARAMETERS USING LANDSAT 8
IMAGERY IN WAY RAREM

By:

VIONITA GUNAWAN

The massive growth of water hyacinth (Eichhornia crassipes) in the Way Rarem
Reservoir, North Lampung, serves as an indicator of ecological pressure impacting
water quality degradation. This study aims to analyze water quality conditions
through Total Suspended Solid (TSS) and chlorophyll-a parameters in 2025. This
analysis was conducted to provide a comprehensive and actual overview of the
water quality conditions in the Way Rarem Reservoir as a basis for sustainable
ecosystem management. This study utilizes Landsat 8 satellite imagery from 2025
as the primary data source. The estimation of Total Suspended Solid (TSS)
concentrations was performed using three empirical algorithms—Budiman, Laili,
and Parwati—which were subsequently validated with in-situ field data, with model
accuracy measured using RMSE. Meanwhile, chlorophyll-a concentrations were
estimated using an algorithm based on the Normalized Difference Chlorophyll
Index (NDCI). The correlation between TSS and chlorophyll-a was tested using the
Pearson correlation statistical method. The results of the 2025 study indicate that
the Budiman algorithm is the best model for estimating TSS, with an RMSE value
of 1.571. The TSS parameter in this study functions as an indicator of suspended
materials that carry nutrient inputs for aquatic vegetation. Based on the chlorophyll-
a mapping using the NDCI index, the water quality status in the Way Rarem
Reservoir is dominated by Hypereutrophic (high fertility) and Mesotrophic
(moderate fertility) statuses, which are concentrated in areas with high water
hyacinth density. The Pearson correlation test results show a positive relationship
between TSS and chlorophyll-a parameters, with a correlation coefficient value of
r = 0.556. This relationship indicates that an increase in the concentration of
suspended materials in the waters contributes to increased water fertility, which
triggers the growth of aquatic vegetation such as water hyacinth in the Way Rarem
Reservoir..

Keywords: Water Quality, Total Suspended Solid, Chlorophyll-a, Remote Sensing
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BAB 1 PENDAHULUAN

1.1 Latar Belakang

Pemanfaatan sumber daya alam secara optimal dan berkelanjutan merupakan salah
satu prasyarat dalam mendukung pembangunan nasional. Air sebagai sumber daya
vital memiliki peran penting dalam memenuhi berbagai kebutuhan masyarakat,
seperti irigasi, perikanan, dan penyediaan air baku. Salah satu upaya pemerintah
dalam mengelola sumber daya air adalah melalui pembangunan bendungan pada
Daerah Aliran Sungai (DAS). Keberadaan bendungan memerlukan pengelolaan

yang baik agar fungsi dan manfaat air dapat dimaksimalkan secara berkelanjutan.

Bendungan Way Rarem yang berlokasi di Desa Pekurun, Kabupaten Lampung
Utara, dibangun pada tahun 1981. Bendungan ini memiliki luas daerah aliran sungai
(DAS) sebesar 328 km? dan termasuk dalam Wilayah Sungai Mesuji Tulang
Bawang. Dengan tipe konstruksi timbunan batu berinti tanah kedap air, bendungan
ini memiliki ketinggian 32 meter, volume timbunan mencapai 1,33 juta m?, luas
genangan normal 1.006,10 hektar, serta kapasitas tampungan air pada ketinggian

normal sebesar 72,4 juta m? (Tumijo dan Ashari, 2022).

Pengelolaan Bendungan Way Rarem berada di bawah kewenangan Pemerintah
Pusat melalui Balai Besar Wilayah Sungai (BBWS) Mesuji Sekampung, karena
bendungan ini mampu mengairi lebih dari 20.000 hektar lahan. Wilayah yang dialiri
air dari bendungan ini mencakup beberapa daerah, seperti Abung Timur, Tulang
Bawang Tengah, Tulang Bawang Udik, dan Kotabumi. Berdasarkan Peraturan
Pemerintah Republik Indonesia Nomor 20 Tahun 2006 tentang Irigasi, pasal 16 ayat
(1d), sistem irigasi yang mencakup wilayah lebih dari 3.000 hektar menjadi

tanggung jawab pemerintah pusat.



Salah satu permasalahan lingkungan yang sering terjadi di Bendungan Way Rarem
adalah pertumbuhan eceng gondok (Eichhornia crassipes) secara masif. Eceng
gondok merupakan tumbuhan air yang banyak dijumpai di perairan terbuka,
khususnya di wilayah tropis dan subtropis. Tumbuhan ini umumnya tumbuh
optimal pada perairan dangkal dengan suhu berkisar antara 28°C hingga 30°C
(Prasetyo dkk., 2021). Pertumbuhan eceng gondok yang tidak terkendali dapat
mengganggu fungsi perairan dan mengindikasikan adanya tekanan ekologis pada

badan air yang dapat mengakibatkan penurunan terhadap kualitas air.

Keberadaan eceng gondok dalam jumlah besar dapat menimbulkan berbagai
dampak negatif, antara lain mempercepat proses pendangkalan, menyumbat saluran
irigasi, menghambat transportasi perairan, serta menurunkan produktivitas
perikanan (Dewantara dkk., 2021). Fenomena blooming eceng gondok umumnya
dipicu oleh tingginya kandungan nutrien di perairan, seperti nitrogen dan fosfor,
yang berasal dari limpasan kegiatan pertanian, limbah domestik, maupun aktivitas

manusia di sekitar bendungan (Poernama dkk., 2023).

Penelitian ini menggunakan pendekatan kuantitatif dengan memanfaatkan data
penginderaan jauh untuk menganalisis kualitas air Bendungan Way Rarem. Data
utama yang digunakan berupa citra satelit Landsat 8 tahun perekaman 2025.
Analisis dilakukan dengan mengekstraksi parameter kualitas air, yaitu Total
Suspended Solid (TSS) dan klorofil-a, melalui penerapan model empiris berbasis
reflektansi spektral. Sebelum proses estimasi parameter, citra satelit terlebih dahulu

dilakukan tahap praproses untuk memastikan kualitas data yang digunakan.

Parameter TSS mengukur jumlah partikel padatan tersuspensi di perairan, termasuk
lumpur, bahan organik, dan limbah, yang dapat menjadi sumber nutrisi bagi
pertumbuhan eceng gondok (Arifelia dkk., 2017). Tingginya nilai TSS
menunjukkan potensi peningkatan biomassa tanaman air akibat ketersediaan
nutrisi. Sementara itu, klorofil-a merupakan pigmen utama dalam fotosintesis yang
digunakan sebagai indikator produktivitas primer di perairan. Konsentrasi klorofil-

a yang tinggi mencerminkan tingginya biomassa tanaman, termasuk eceng gondok,



sehingga dapat menjadi indikator langsung terjadinya blooming (Nugraheni dkk.,
2022).

Berdasarkan permasalahan lingkungan yang terjadi di Bendungan Way Rarem,
khususnya pertumbuhan eceng gondok yang mengindikasikan penurunan kualitas
perairan, diperlukan pemantauan kualitas air yang akurat dan efisien. Pemanfaatan
citra satelit Landsat 8 tahun perekaman 2025 digunakan sebagai alternatif dalam
mengevaluasi kondisi kualitas air terkini melalui parameter Total Suspended Solid
(TSS) dan klorofil-a. Analisis kualitas air pada tahun 2025 ini diharapkan mampu
memberikan gambaran aktual mengenai tingkat tekanan ekologis di Bendungan
Way Rarem serta menjadi dasar ilmiah dalam mendukung upaya pengelolaan dan

pengendalian perairan secara berkelanjutan.

1.2 Rumusan Masalah

Pertumbuhan eceng gondok (Eichhornia crassipes) yang masif di Bendungan Way

Rarem, Kabupaten Lampung Utara menjadi indikator adanya tekanan ekologis

yang berdampak pada penurunan kualitas air. Berdasarkan permasalahan tersebut,

maka pertanyaan penelitian dalam penelitian ini adalah:

1. Bagaimana distribusi spasial konsentrasi Total Suspended Solid (TSS) dan
klorofil-a di Bendungan Way Rarem tahun 2025 menggunakan citra satelit
Landsat 8?

2. Manakah algoritma estimasi TSS yang memiliki tingkat akurasi tertinggi
berdasarkan validasi terhadap data lapangan?

3. Bagaimana hubungan nilai konsentrasi TSS dan nilai klorofil-a terhadap status

trofik sebagai indikator kualitas air di Bendungan Way Rarem?

1.3 Tujuan Penelitian

Tujuan dilakukan penelitian ini adalah:

1. Menganalisis distribusi spasial nilai TSS dan klorofil-a di Bendungan Way
Rarem pada tahun 2025 berdasarkan citra Landsat 8.



2. Mengevaluasi tingkat akurasi algoritma estimasi TSS (Budiman, Laili, dan

Parwati) untuk menentukan model terbaik melalui perhitungan nilai RMSE
Menganalisis hubungan antara konsentrasi TSS dan klorofil-a dalam
menentukan status trofik perairan sebagai indikator kualitas air di Bendungan

Way Rarem secara spasial.

1.4 Manfaat Penelitian

Manfaat yang ingin diperoleh dari penelitian ini adalah:

1.

Bagi penulis.

Penelitian ini diharapkan dapat meningkatkan dan melatih kemampuan penulis
untuk mengolah, menganalisis dan menyajikan data dengan metode yang
dipilih.

Bagi Pemerintah.

Penelitian ini dapat menjadi salah satu referensi untuk mengetahui kualitas
perairan Bendungan Way Rarem sebagai salah satu dasar untuk pengelolaan

dan pemeliharaan Bendungan Way Rarem.

. Bagi pihak lain.

Penelitian ini dapat menjadi referensi bacaan bagi peneliti lain yang akan

melakukan penelitian dengan topik yang berkaitan.

1.5 Ruang Lingkup Penelitian

Ruang lingkup penelitian digunakan untuk menghindari adanya penyimpangan

maupun pelebaran pokok masalah agar penelitian tersebut lebih terarah dan

memudahkan dalam pembahasan sehingga tujuan penelitian akan tercapai. Ruang

lingkup dalam penelitian ini adalah:

1.

Wilayah penelitian dilakukan di Bendungan Way Rarem, Kabupaten Lampung
Utara.

Penelitian ini menggunakan citra Landsat 8 Level 2 tahun perekaman 2025.

. Algoritma perhitungan kandungan Total Suspended Solid (TSS) dan klorofil-a

menggunakan algoritma empiris.



4. Data Lapangan yang digunakan untuk validasi model akurasi citra satelit hanya
untuk parameter Total Suspended Solid (TSS). Analisis klorofil-a tidak
dilakukan validasi menggunakan data lapangan karena keterbatasan data.

5. Penelitian ini berfokus pada kualitas air bedasarkan nilai TSS dan klorofil-a.

1.6 Hipotesis

Kondisi kualitas air Bendungan Way Rarem pada tahun 2025 dapat
direpresentasikan melalui nilai Total Suspended Solid (TSS) dan klorofil-a yang
diestimasi menggunakan citra Landsat 8. Nilai TSS dan klorofil-a yang relatif tinggi
mencerminkan tingginya tingkat kekeruhan dan kesuburan perairan, yang
mengindikasikan adanya tekanan lingkungan akibat masuknya material tersuspensi
dan nutrien dari aktivitas di daerah aliran sungai. Terdapat keterkaitan antara nilai
TSS dan klorofil-a dalam menggambarkan kondisi kualitas air Bendungan Way

Rarem pada tahun 2025.



BAB 2 TINJAUAN PUSTAKA

2.1 Penelitian Terdahulu

Dalam proses penelitian, penulis dapat menjadikan penelitian terdahulu sebagai
referensi dalam segi tulisan, ide, dan hal teknis lainnya. Penelitian terdahulu juga
digunakan untuk mencari perbandingan dan menunjukkan gap atau orisinalitas dari
penelitian yang akan dilakukan. Selain itu, penelitian terdahulu juga berfungsi
sebagai referensi untuk mendukung kajian dalam penelitian ini. Berikut merupakan

penelitian terdahulu yang berkaitan dengan penelitian yang akan dilakukan.

Tabel 1. Penelitian terdahulu

No Penulis, Tahun,
Judul

Metode

Hasil Penelitian

1. Dewinta Heriza,
Abdi Sukmono,
Nurhadi Bashit

Tahun (2018)

Analisis
Perubahan
Kualitas Perairan
Danau Rawa
Pening Periode
2013, 2015 dan
2017 Dengan
Menggunakan
Data Citra
Landsat 8
Multitemporal

Penelitian ini
menggunakan
algoritma regresi
yang divalidasi
dengan data
lapangan, algoritma
Parwati untuk TSS
dan algoritma
Doxaran untuk
kecerahan. Selain itu,
analisis klasifikasi
tutupan lahan
dilakukan dengan
metode klasifikasi
terbimbing secara
multitemporal.

Hasil penelitian
menunjukkan bahwa
kualitas perairan Danau
Rawa Pening mengalami
perubahan signifikan. Pada
tahun 2013, kondisi
tercemar berat sebesar
1,2%, turun menjadi 0%
pada 2015 dan 0,1% pada
2017. Kecerahan danau
pada kondisi hipertrofik
juga bervariasi, dengan
peningkatan transparansi
dari 0,07% pada 2015
menjadi 46,56% pada 2017.
Sebaran vegetasi air
menunjukkan penurunan
sebesar 31,28%
dibandingkan tahun 2013.

2 Silmina Laili,
Bowo Eko

Penelitian ini
menggunakan citra

Hasil penelitian
menunjukkan bahwa




Lanjutan tabel 1. Penelitian terdahulu

Penulis, Tahun,

No Metode Hasil Penelitian
Judul
Cahyono, Agung  satelit Landsat-8 mayoritas nilai TSS berada
Tjahjo Nugroho untuk memantau di bawah 25 mg/L, dengan
kualitas air Danau persentase terbesar antara
Tahun (2020) Batur dari tahun 2014 97,86% hingga 98,66%
hingga 2018. selama periode 2014-2018.

Analisis Kualitas

Parameter yang

Tingkat kecerahan danau

Air di Danau diukur meliputi 7otal  pada kondisi hiperutrofik
Batur Suspended Solid berkisar antara 1,66%
Mengggunakan (TSS), kecerahan, hingga 2,74%. Persentase
Citra Landsat-8 dan klorofil-a. klorofil-a terbesar berada di
OLI/TIRS Pengolahan data TSS ~ bawah 2 mg/m?,
Multitemporal dilakukan dengan menunjukkan kondisi
algoritma Trisakti, oligotrofik. Secara
sementara klorofil-a  keseluruhan, nilai TSS dan
menggunakan klorofil-a tidak
algoritma Wibowo. memengaruhi perikanan
secara signifikan.
3 Aditya Hafidh Pemilihan algoritma  Hasil penelitian
Baktiar, Arwan terbaik untuk estimasi menunjukkan bahwa kadar
Putra Wijaya, TSS dan klorofil-a klorofil-a di perairan
Abdi Sukmono dilakukan dengan tersebut bervariasi antara
menganalisis korelasi  tahun 2003 hingga 2016.
Tahun (2016) antara data citra Berdasarkan status trofik,
pengamatan dan data  pada tahun 2003, 2014, dan
Analisis sampel dari perairan 2016, kadar klorofil-a
Kesuburan dan Banjir Kanal Timur.  paling dominan berada di
Pencemaran Air Titik pengambilan rentang 0-2,6 mg/l, tersebar
Berdasarkan sampel ditetapkan di tepi pantai, muara sungai,
Kandungan secara acak. hingga laut lepas. Status
Klorofil-A dan trofik yang lebih kecil,
Konsentrasi Total seperti eutrof (7,3-56 mg/l),
Suspended Solid mesotrof (2,6-7,3 mg/l), dan
Secara hipereutrof (>56 mg/1),
Multitemporal di umumnya ditemukan di
Muara Banjir muara sungai dan tepi
Kanal Timur pantai.
4  N. Lail, F. Membangun Penelitian ini menggunakan
Arafah, L. M. algoritma baru untuk  data dari satelit Landsat 8
Jaelani, L. Subehi, mengukur konsentrasi dengan tujuan

A. Pamungkas, E.
S. Koenhardono,
and A.
Sulisetyono

Tahun (2015)

TSS dan Klorofil-A
menggunakan data in
situ dan Citra Landsat
8 di wilayah perairan
Kecamatan Sumenep,
Madura.

mengembangkan algoritma
yang lebih akurat dalam
mengestimasi konsentrasi
TSS dan Chl-a. Metode
yang diterapkan dalam
penelitian ini mencakup
Analisis Regresi, Koreksi




Lanjutan tabel 1. Penelitian terdahulu

Penulis, Tahun,

No Metode Hasil Penelitian
Judul

Development of Radiometrik, Koreksi
Water Quality Atmosfer, serta Pengolahan
Parameter Data In Situ. Hasil
Retrieval penelitian ini menghasilkan
Algorithms for algoritma baru yang dapat
Estimating Total dimanfaatkan untuk
Suspended Solids memperkirakan nilai TSS
and Chlorophyll- serta konsentrasi Chl-a di
A Concentration berbagai wilayah di
Using Landsat-8 Indonesia.
Imagery at
Poteran Island
Water’

5  Vionita Gunawan Penggunaan Hasil penelitian ini

Tahun (2026)

Analisis Kualitas
Air Berdasarkan
Parameter Total
Suspended Solid
dan Klorofil-a
Menggunakan
Citra Landsat 8 di
Bendungan Way
Rarem

algoritma empiris
(Laili, Budiman,
Parwati) untuk
estimasi TSS yang

divalidasi melalui uji

akurasi RMSE
dengan data
lapangan, serta
penerapan indeks

NDCI untuk estimasi

klorofil-a.
Metodologi
dilengkapi analisis
korelasi Pearson
untuk menentukan
status trofik
berdasarkan baku
mutu perairan.

menunjukan bahwa
algoritma Budiman terpilih
sebagai model estimasi
terbaik untuk parameter
Total Suspended Solid
(TSS) dengan nilai akurasi
RMSE sebesar 1,571 yang
kemudian diikuti dengan
penerapan indeks
Normalized Difference
Chlorophyll Index (NDCI)
untuk mengekstraksi nilai
sebaran klorofil-a secara
spasial pada seluruh
bendungan. Berdasarkan
hasil integrasi serta korelasi
antara kedua parameter
tersebut, status kualitas air
di Bendungan Way Rarem
teridentifikasi secara akurat
masuk dalam kategori
Hipereutrofik (kesuburan
sangat tinggi), yang secara
teknis mengonfirmasi
penyebab utama terjadinya
fenomena ledakan populasi
eceng gondok secara masif
di lokasi studi.

Berdasarkan penelitian-penelitan terdahulu yang telah diuraikan, penelitian ini

melakukan elaborasi mendalam pada aspek metodologi untuk mengisi celah



penelitian (research gap) yang belum dibahas secara spesifik oleh peneliti
terdahulu. Perbedaan mendasar skripsi ini dengan studi Laili dkk. (2015) atau
Budiman (2004) terletak pada pendekatan komparasi multi-algoritma (Laili,
Budiman, dan Parwati) untuk menentukan model ekstraksi TSS yang paling baik
terhadap gangguan spektral di ekosistem bendungan. Hal ini menjadi penting
mengingat karakteristik perairan di Bendungan Way Rarem memiliki tingkat
kekeruhan tinggi dan tutupan vegetasi yang rapat, sehingga diperlukan pengujian
akurasi yang lebih ketat melalui uji RMSE berbasis data in-situ untuk memvalidasi

performa masing-masing algoritma tersebut..

Selain itu, kebaruan metodologi dalam penelitian ini adalah adanya integrasi
parameter kualitas air secara spasial, di mana nilai TSS sebagai indikator material
pembawa nutrien dikorelasikan dengan konsentrasi klorofil-a yang diekstraksi
menggunakan indeks NDCI (Normalized Difference Chlorophyll Index). Sebagian
besar peneliti terdahulu hanya berfokus pada analisis parameter tunggal, sementara
skripsi ini mengombinasikan keduanya menggunakan analisis korelasi Pearson

guna menentukan status trofik atau kelas air berdasarkan baku mutu perairan.

2.2 Penginderaan Jauh

Penginderaan jauh dapat didefinisikan sebagai teknik untuk mengamati, mengukur,
dan mengidentifikasi objek atau fenomena yang ada di permukaan bumi
menggunakan sensor yang terpasang pada satelit atau pesawat terbang (Lillesand et
al., 2015). Dengan penginderaan jauh, data yang dikumpulkan berupa citra atau

gambar yang merepresentasikan kondisi permukaan bumi pada waktu tertentu.

Penginderaan jauh berfungsi berdasarkan prinsip pemancaran dan penerimaan
energi elektromagnetik. Sumber energi ini dapat berupa sinar matahari atau radiasi
buatan. Sensor penginderaan jauh akan mendeteksi refleksi atau radiasi yang
dipancarkan atau dipantulkan oleh permukaan bumi, kemudian mengubahnya

menjadi data yang dapat dianalisis lebih lanjut. Sensor pada penginderaan jauh
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memiliki kemampuan untuk menangkap berbagai spektrum elektromagnetik,

termasuk cahaya tampak, inframerah dekat, dan termal (Jensen, 2014).

Sensor dalam penginderaan jauh dibagi menjadi dua kategori utama, yaitu sensor
pasif dan sensor aktif. Sensor pasif seperti satelit Landsat menggunakan cahaya
matahari sebagai sumber energi, sementara sensor aktif seperti radar dan LiDAR
(Light Detection and Ranging) menghasilkan energi sendiri untuk mendeteksi objek

(Campbell and Wynne, 2011).

2.3 Landsat 8

Landsat 8 merupakan satelit yang diluncurkan pada 11 Februari 2013 oleh NASA
dan United States Geological Survey (USGS). Satelit ini adalah bagian dari
program Landsat yang telah berlangsung sejak tahun 1972 (Markham et al., 2015).
Satelit Landsat 8 memiliki kemampuan penginderaan jauh dengan cakupan yang
luas, yang sangat berguna dalam pemetaan penggunaan lahan, perubahan tutupan
lahan, pemantauan kualitas air, dan banyak aplikasi lainnya. Citra Landsat 8 dapat
digunakan dalam pemetaan global dan analisis perubahan lingkungan jangka
panjang (Giglio et al., 2016). Landsat 8 menggantikan Landsat 7 dan membawa dua

instrumen utama:

2.3.1 Instrumen Operational Land Imager (OLI)
OLI berfungsi untuk mengambil gambar dengan resolusi spasial 30 meter pada

delapan saluran spektral yang berbeda, yang mencakup panjang gelombang dari

ultraviolet hingga inframerah (Markham ef al., 2015).

2.3.2 Instrumen Thermal Infrared Sensor (TIRS)

TIRS berfungsi untuk mengukur radiasi termal di dua saluran inframerah termal

dengan resolusi spasial 100 meter (Markham et al., 2015).
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2.4 Total Suspended Solid (TSS)

Total Suspended Solid (TSS) adalah materi padat yang mencakup lumpur, tanah,
logam berat, bahan organik, dan sel mikroorganisme yang terlarut di perairan. TSS
berhubungan erat dengan erosi tanah dari saluran sungai. Konsentrasi TSS dapat
bervariasi secara signifikan, kurang dari 5 mg/L hingga 30.000 mg/L di beberapa
sungai. Padatan tersuspensi atau suspended solids adalah partikel dengan ukuran
0,45 sampai dengan 2,0 mm yang ada di kolom air. Partikel-partikel ini memiliki
kemampuan untuk menyerap elemen atau senyawa kimia baik yang organik

maupun anorganik yang terlarut (Libes, 1992).

Nilai reflektansi suatu badan air dapat dipengaruhi oleh materi organik dan
anorganik yang tersuspensi di dalamnya. Kondisi dan kualitas perairan dapat diukur
melalui informasi tentang pantulan cahaya tampak dari badan air tersebut.
Konsentrasi padatan tersuspensi berkaitan langsung dengan nilai reflektansi
gelombang. Pada panjang gelombang antara 600 nm hingga 700 nm, perairan
dengan konsentrasi padatan tersuspensi yang tinggi menunjukkan pantulan radiasi
matahari yang paling kuat. Sebaliknya, semakin rendah konsentrasi padatan
tersuspensi di permukaan air, semakin rendah pula pantulan radiasi matahari.

(Robinson, 1985).

Tabel 2. Klasifikasi konsentrasi TSS

Kelas Konsentrasi TSS (mg/L) Keterangan Kualitas Air
I <25 mg/L Sangat baik / sangat jernih
II 25 -50 mg/L Baik
I 50 — 100 mg/L Sedang
v > 100 mg/L Buruk / sangat keruh

Penentuan nilai ambang batas pada masing-masing kelas Total Suspended Solid
(TSS) didasarkan pada baku mutu kualitas air yang mengacu pada Peraturan
Pemerintah Republik Indonesia Nomor 22 Tahun 2021. Nilai TSS kemudian
dikelompokkan ke dalam beberapa kelas kualitas air untuk merepresentasikan

tingkat kekeruhan perairan, mulai dari kondisi sangat baik hingga kondisi buruk.
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Pembagian kelas ini digunakan sebagai dasar dalam interpretasi spasial kualitas air

Bendungan Way Rarem.

2.5 Algoritma Penentuan Konsentrasi TSS

Algoritma Parwati merupakan salah satu model empiris yang digunakan untuk
mengestimasi konsentrasi Total Suspended Solid dari data citra satelit. Algoritma
ini dikembangkan oleh Parwati pada tahun 2014 berdasarkan penelitian yang
dilakukan di perairan Berau. Model ini memanfaatkan nilai reflektansi kanal merah
yang telah dikoreksi secara atmosferik sebagai variabel input utama, karena kanal
merah diketahui sensitif terhadap keberadaan partikel tersuspensi di perairan

(Permatasari, 2020). Persamaan algoritma Parwati dirumuskan sebagai berikut:

TSS(E) =0,6211 * (7,9038 " exp(23,942*z4))0,9645 .............................................................. (1)
!

Keterangan:

TSS = Muatan padat tersuspensi

A4 = Band 4 (Red)

Algoritma Laili merupakan metode empiris yang dikembangkan oleh Laili pada
tahun 2015 untuk menduga konsentrasi TSS menggunakan data citra satelit
multispektral. Algoritma ini disusun berdasarkan hubungan antara reflektansi
spektral permukaan dengan konsentrasi TSS hasil pengukuran lapangan. Penelitian
Laili (2015) dilakukan di perairan Poteran, Madura, dengan memanfaatkan rasio
logaritmik reflektansi kanal biru dan kanal merah sebagai input model. Formulasi

algoritma Laili dituliskan sebagai berikut:

TSS(™y = 31,42 « (242 _

( =) A2 (logm)) 12,709 e, )
Keterangan:
TSS = Muatan padat tersuspensi

A2 = Band 2 (Blue)
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A4 = Band 4 (Red)

Algoritma Budiman merupakan algoritma empiris yang dikembangkan oleh
Budiman (2004) untuk mengestimasi konsentrasi Total Suspended Solid (TSS)
berbasis data penginderaan jauh. Algoritma ini dibangun dengan menghubungkan
nilai reflektansi kanal merah citra satelit dengan konsentrasi TSS hasil pengukuran
lapangan. Hubungan tersebut dinyatakan dalam bentuk fungsi eksponensial,
dimana peningkatan nilai reflektansi kanal merah menunjukkan peningkatan
konsentrasi padatan tersuspensi di perairan. Persamaan algoritma Budiman

dinyatakan sebagai berikut:

TSS(Z2) = 8,1249 + exp @70 3)
TSS = Muatan padat tersuspensi
A4 = Band 4 (Red)

2.5 Klorofil-a

Klorofil adalah pigmen hijau yang terdapat dalam kloroplas, dan terdiri dari dua
jenis: klorofil-a yang berwarna hijau tua dan klorofil-b yang berwarna hijau muda
(Dwidjoseputro, 1980). Klorofil-a adalah zat padat hijau-biru mikrostalin yang
berfungsi sebagai pigmen utama dalam fotosintesis pada semua tanaman.
Konsentrasi klorofil-a berkaitan dengan masalah eutrofikasi yang disebabkan oleh
pertumbuhan alga. Klorofil-a ditemukan pada tumbuhan, alga, dan cyanobacteria,
dan digunakan sebagai indikator utama untuk menentukan status trofik perairan.
Klorofil-a juga berperan dalam menghubungkan konsentrasi nutrisi, khususnya
fosfor, dengan produksi alga. Eutrofikasi adalah masalah dalam ekosistem perairan,
baik tawar maupun laut, dan dapat dikenali melalui peningkatan kadar unsur hara

dalam air (Dwidjoseputro, 1980).

Peningkatan klorofil-a yang tidak terkendali dapat mengancam fungsi waduk,

menyebabkan pendangkalan, menurunkan kualitas perairan, dan mengancam
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kehidupan biota perairan. Penginderaan jauh sering digunakan untuk
memperkirakan konsentrasi klorofil-a dalam perairan dengan memanfaatkan
karakteristik spektral klorofil-a. Klorofil-a menyerap cahaya paling banyak pada
panjang gelombang 390nm sampai dengan 400nm dan 650nm sampai dengan
700nm (Harborne and Dey, 1990). Warna hijau pekat klorofil disebabkan oleh
kemampuannya menyerap cahaya di spektrum merah dan biru, sehingga cahaya

yang dipantulkan dan dipancarkannya tampak hijau.

2.6 Normalized Difference Water Index (NDWI)

Normalized Difference Water Index (NDWI) adalah indeks berbasis penginderaan
jauh yang digunakan untuk mendeteksi dan memantau tubuh air pada citra satelit.
Indeks ini pertama kali diperkenalkan oleh McFeeters (1996) untuk mengekstraksi
informasi terkait keberadaan air dengan meningkatkan kontras antara area perairan
dan daratan. NDWI dihitung dengan menggunakan rasio reflektansi dari kanal
Green dan Near-Infrared (NIR) dalam spektrum elektromagnetik, dengan rumus

sebagai berikut:

NDWI = (GTEEIM=INIR) ..ottt ettt ettt b e e st et e be e st e st e ebeeseenseebeestenaeeseeneensenne (5)
(Green+NIR)

Keterangan:
Green = Band hijau (sekitar 0,52 - 0,60 um)
NIR = Band Near-Infrared (sekitar 0,76 - 0,90 um)

NDWI memiliki nilai berkisar antara -1 hingga 1, dimana nilai positif menunjukkan
keberadaan air, sedangkan nilai negatif atau mendekati nol menunjukkan vegetasi
dan tanah kering (McFeeters,1996)

2.7 Normalized Difference Chlorophyll Index (NDCI)

Normalized Difference Chlorophyll Index (NDCI) merupakan indeks penginderaan

jauh yang dirancang khusus untuk memprediksi konsentrasi klorofil-a di perairan
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produktif seperti muara, waduk dan pantai yang sering kali sulit diukur
menggunakan algoritma berbasis biru-hijau akibat interferensi dari CDOM dan
partikel tersuspensi. Indeks ini memanfaatkan Remote sensing reflectance (Rrs)
pada panjang gelombang 665 nm (absorpsi chl-a) dan 708 nm (puncak reflectance
NIR merah), mirip konsep NDVI untuk vegetasi, sehingga mengurangi sensitivitas

terhadap variasi cahaya dan atmosfer (Mishra, 2012).

NDCI menunjukkan keunggulan dibandingkan indeks seperti OC2, OC3, dan
model lain pada perairan keruh karena rentang output standar -1 hingga +1 yang
mirip NDVI, sehingga mengurangi kebutuhan kalibrasi site-specific dan
meminimalkan interferensi atmosfer serta variasi sudut matahari (Mishra et al.,

2014). Rumus NDCI didefinisikan sebagai berikut:

NIR—Red

NDCI :m .......................................................................... (6)

Meskipun NDCI dan NDVI memiliki rumus yang identik pada Landsat 8
(menggunakan Band NIR dan merah), fungsionalitas dan konteks penerapannya
sangat berbeda. NDVI secara eksklusif berfokus pada vegetasi darat (terestrial),
dengan nilai indeks tingginya menjadi produk akhir yang mengukur kesehatan dan
kepadatan tanaman. Sebaliknya, NDCI digunakan secara spesifik untuk
menganalisis perairan, dimana nilai indeks yang dihasilkan berfungsi sebagai
variabel prediktor (input) yang dimasukkan ke dalam persamaan regresi empiris.
Tujuannya adalah untuk menghitung dan memodelkan nilai fisik, yaitu konsentrasi
klorofil-a, yang merupakan indikator langsung dari tingkat produktivitas primer dan

kualitas trofik air.

2.8 Algoritma Penentuan Klorofil-a

Estimasi konsentrasi klorofil-a dalam penelitian ini dilakukan menggunakan
algoritma Normalized Difference Chlorophyll Index (NDCI) yang dikembangkan

oleh Mishra (2012). Algoritma ini memanfaatkan perbedaan reflektansi spektral
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antara kanal inframerah dekat dan kanal merah yang sensitif terhadap keberadaan
pigmen klorofil di perairan. Berdasarkan prinsip tersebut, nilai NDCI dihitung
sebagai rasio antara selisih dan jumlah reflektansi kedua kanal, yang secara

matematis dinyatakan dalam persamaan sebagai berikut:

Chlorophyll — a (m—i) = 15,60 (Z40ANDCD (7)
m.

Penggunaan koefisien empiris ini didasarkan pada hasil kalibrasi yang dilakukan
oleh Mishra (2012) pada perairan produktif dan keruh, sehingga model tersebut
dinilai sesuai untuk estimasi klorofil-a pada perairan danau atau waduk. Dalam
penelitian ini, koefisien regresi diadopsi dari literatur dan tidak diturunkan dari data
lapangan, sehingga hasil perhitungan klorofil-a bersifat estimasi berbasis

penginderaan jauh.
2.9 Root Mean Square Error (RMSE)

Root Mean Square Error (RMSE) adalah ukuran statistik yang digunakan untuk
menilai perbedaan antara nilai hasil pengolahan model dengan nilai sebenarnya atau
data lapangan (Faridzie dkk., 2023). RMSE dihitung dari akar rata-rata kuadrat
selisih antara nilai model dan nilai observasi, sehingga semakin kecil nilai RMSE
menunjukkan akurasi model yang lebih baik (Chai and Draxler, 2014). Rumus
RMSE dituliskan sebagai berikut:

A=\/izn (X _X)Z ......................................................................................................................... (8)
n =1 m e

Keterangan:

Xe = Nilai pengukuran lapngan (ground truth)
Xm = Nilai hasil pengolahan citra

n = Jumlah data
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2.10 Status Trofik Perairan

Status trofik perairan merupakan indikator tingkat kesuburan suatu badan air yang
mencerminkan ketersediaan unsur hara serta tingkat produktivitas biologis di
dalamnya. Kesuburan perairan sangat dipengaruhi oleh kandungan nutrien,
terutama nitrogen (N) dan fosfor (P), yang berperan dalam mendukung
pertumbuhan fitoplankton dan organisme autotrof lainnya. Peningkatan konsentrasi
nutrien secara berlebihan dapat menyebabkan eutrofikasi, yaitu proses pengkayaan
unsur hara yang memicu pertumbuhan alga secara masif dan berpotensi

menurunkan kualitas air.

Menurut klasifikasi yang dikembangkan oleh Robert E. Carlson melalui metode
Trophic State Index (TSI), status trofik perairan dapat ditentukan berdasarkan
parameter transparansi, konsentrasi klorofil-a, dan total fosfor. Klorofil-a sering
digunakan sebagai parameter utama karena merepresentasikan biomassa
fitoplankton secara langsung dan berkorelasi erat dengan tingkat produktivitas
primer. Dalam konteks penelitian ini, pendekatan berbasis konsentrasi klorofil-a
digunakan untuk menentukan kategori trofik, di mana status perairan
diklasifikasikan menjadi oligotrof (<2 ng/L) yang mencerminkan kondisi perairan
jernih, mesotrof (2-7 pg/L) dengan tingkat kesuburan sedang, eutrof (7-30 pg/L)
menandakan air yang sudah terlalu subur sehingga mulai terlihat keruh dan
dipenuhi tanaman liar, dan kategori hipereutrofik (>30 pg/L) mengindikasikan
kondisi air yang sangat amat subur atau kelewat batas, di mana tingkat kesuburan
yang ekstrem inilah yang menjadi alasan utama mengapa eceng gondok bisa

tumbuh meledak dan menutupi hampir seluruh permukaan Bendungan Way Rarem.

Klasifikasi tersebut memberikan gambaran mengenai kondisi ekologis perairan,
mulai dari perairan yang miskin nutrien hingga perairan yang sangat subur dan

rentan terhadap gangguan kualitas lingkungan.



BAB 3 METODOLOGI PENELITIAN

3.1 Lokasi Penelitian

Penelitian ini dilaksanakan di Kawasan Bendungan Way Rarem yang berlokasi di
Kecamatan Abung Pekurun, Kabupaten Lampung Utara, Provinsi Lampung.
Dengan pengelolaan yang tepat Bendungan Way Rarem memiliki potensi yang
besar sebagai sumber air yang dapat dimanfaatkan baik dalam segi ekonomi
maupun kehidupan bermasyarakat. Salah satu aspek penting yang harus di

perhatikan yaitu mengenai kualitas air lingkungan itu sendiri,
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Gambar 1. Lokasi penelitian
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3.2 Alat dan Data

Penelitian ini menggunakan berbagai alat dan data. Berikut adalah alat dan data

yang digunakan dalam penelitian ini:

3.2.1 Alat

Penelitian ini bertujuan mengevaluasi kualitas air Bendungan Way Rarem tahun
2025 melalui analisis sebaran TSS dan klorofil-a berbasis penginderaan jauh. Untuk
mendukung efisiensi pengolahan dan analisis data tersebut, perangkat lunak yang

digunakan adalah sebagai berikut

Tabel 3. Peralatan penelitian

No Perangkat Lunak Fungsi

1 Perangkat lunak GIS Digunakan untuk melakukan pengolahan data
penelitian

2 IBM SPSS Statistic Digunakan untuk perhitungan statistika pengujian
hasil data TSS

3 Google Earth Pro Digunakan sebagai alat bantu visualisasi untuk

mengidentifikasi ~ wilayah  penelitian  dan

menentukan batas area kajian secara spasial.

4 Mincrosoft Word Digunakan untuk menyusun laporan penelitian
5 Microsoft Excel Digunakan untuk perhitungan statistika pengujian
hasil data TSS

3.2.2 Data Penelitian

Penentuan waktu penelitian yang difokuskan pada tahun 2025 dilakukan untuk
menggambarkan kondisi kualitas air Bendungan Way Rarem pada periode
penelitian. Penelitian ini dimaksudkan untuk memperoleh informasi yang
merepresentasikan kondisi aktual perairan berdasarkan parameter Total Suspended

Solid (TSS) dan klorofil-a. Dengan fokus pada satu waktu, analisis dapat dilakukan
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secara lebih terarah dalam menilai tingkat kekeruhan dan kesuburan perairan

sebagai indikator kualitas air.

Tabel 4. Data penelitian
No Data Jenis Sumber Data

U.S. Geological Survey
(USGS)

Pengambilan sampel langsung

1  Citra Landsat 8 tahun 2025 Data Sekunder

2 Data sampel air Data Primer _
di lapangan

Interpretasi visual dari citra
3 Data area bendungan Data Sekunder o
resolusi tinggi

Dalam penelitian ini, penulis memanfaatkan berbagai jenis data yang memiliki
relevansi tinggi serta berkaitan langsung dengan topik utama penelitian. Seluruh
rangkaian data tersebut, yang mencakup klasifikasi data primer maupun data
sekunder, telah melalui proses verifikasi dan validasi secara saksama guna
menjamin tingkat akurasi serta reliabilitas hasil yang akan dicapai agar selaras

dengan tujuan penelitian.

3.3 Diagram Alir Penelitian

Tahapan pada penelitian ini meliputi tahap persiapan, tahap pengolahan, analisis

data, dan tahap akhir. Berikut merupakan diagram alir dari penelitian ini.
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Gambar 2. Diagram alir penelitian
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3.4 Tahap Persiapan Penelitian

Berikut merupakan tahapan persiapan dalam penelitian ini:

3.4.1 Studi Literatur

Pelaksanaan penelitian ini diawali dengan studi literatur yang didefinisikan sebagai
peninjauan sistematis terhadap literatur ilmiah yang sudah ada (seperti jurnal dan
buku) yang berkaitan dengan topik penelitian. Tujuan utama dari proses ini adalah
untuk menetapkan landasan teoritis bagi penelitian yang dilakukan, sekaligus untuk
memetakan perkembangan ilmu, mengidentifikasi kekurangan dari penelitian
terdahulu, dan mengevaluasi pendekatan metodologi yang relevan. Oleh karena itu,
studi literatur memegang peranan penting dalam memberikan konteks akademis

dan arahan bagi penelitian.

3.4.2 Pengumpulan Data

Data yang digunakan pada penelitian ini adalah citra satelit Landsat 8 yang
bersumber dari U.S. Geological Survey (USGS). Citra satelit ini merupakan data
berjenis raster dan digunakan untuk memantau perubahan dari waktu ke waktu.
Periode waktu yang digunakan adalah tahun 2025. Selain itu, data area bendungan
diperoleh melalui Interpretasi visual dari citra resolusi tinggi menggunakan perangkat
lunak Google Earth Pro, yang merupakan data berjenis vekfor. Data primer
diperoleh melalui survei lapangan, yang meliputi pengambilan data sampel air di
lokasi penelitian. Data sampel air ini digunakan untuk verifikasi dan analisis lebih

lanjut, melengkapi informasi yang didapat dari data sekunder.

Data primer yang dikumpulkan melalui survei lapangan memiliki peran krusial
dalam validasi dan kalibrasi model citra satelit, khususnya untuk parameter TSS.
Pengambilan sampel air dilakukan secara langsung di berbagai titik koordinat di
bendungan, yang mana titik-titik ini dipilih secara strategis untuk mewakili variasi

TSS. Untuk memberikan gambaran komprehensif mengenai distribusi lokasi
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penelitian, seluruh titik pengambilan sampel air tersebut telah dipetakan secara
spasial berdasarkan koordinat geografisnya, sebagaimana disajikan dalam peta

sebaran titik sampel pada gambar berikut.
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Gambar 3. Peta sebaran sampel TSS.

Berdasarkan peta sebaran titik sampel Total Suspended Solid (TSS) di Bendungan
Way Rarem, titik pengambilan sampel ditentukan untuk merepresentasikan variasi
kondisi perairan di seluruh area bendungan, baik pada bagian hulu, tengah, maupun

hilir. Setiap titik sampel yang ditampilkan pada peta selanjutnya dicatat posisi
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geografisnya secara rinci dalam bentuk koordinat untuk memastikan ketelitian
lokasi pengamatan dan kemudahan dalam analisis spasial lanjutan. Oleh karena itu,
tabel koordinat disajikan untuk memuat informasi posisi masing-masing titik
sampel dalam sistem proyeksi Universal Transverse Mercator (UTM) datum WGS
1984 zona 48S, yang menjadi acuan dalam pengolahan dan interpretasi data TSS

pada penelitian ini.

Tabel 5. Koordinat titik sampel data TSS

Nama Koordinat (m)
X Y
Sampel 1 476.188,3607 9.455.142,017
Sampel 2 475.979,5417 9.453.310,072
Sampel 3 475.841,1579 9.452.711,273
Sampel 4 476.941,1349 9.450.853,955
Sampel 5 477.529,5029 9.450.227,750
Sampel 6 476.559,3108 9.452.615,059
Sampel 7 474.453,6616 9.454.633,010
Sampel 8 475.668,9644 9.454.332,862
Sampel 9 475.470,0704 9.456.034,862
Sampel 10 474.795,5416 9.455.563,881
Sampel 11 476.604,3344 9.454.249,039
Sampel 12 476.029,1857 9.451.853,038
Sampel 13 475.981,6445 9.451.132,633
Sampel 14 477.037,9558 9.451.994,110
Sampel 15 475.787,6988 9.455.370,886
Sampel 16 474.906,2551 9.453.754,575
Sampel 17 475.013,3581 9.454.351,992

Lokasi pengambilan data sampel ditetapkan pada 17 titik sampel yang tersebar di
area Bendungan Way Rarem, sebagaimana disajikan dalam tabel koordinat. Setiap
titik sampel dicatat posisi spasialnya menggunakan sistem koordinat Universal
Transverse Mercator (UTM), dengan koordinat X dan Y yang merepresentasikan
posisi horizontal secara presisi. Pendataan koordinat ini dilakukan untuk

memastikan ketepatan lokasi pengambilan sampel, memudahkan penelusuran di
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lapangan, serta mendukung integrasi data lapangan dengan data penginderaan jauh

pada tahap analisis selanjutnya.

Pengambilan data primer dilakukan dengan mengambil sampel di beberapa titik
yang telah ditentukan. Sampel air diambil pada kedalaman minimal 30 cm dari
permukaan perairan untuk menghindari pengaruh langsung kondisi permukaan. Air
kemudian dimasukkan ke dalam botol sampel berkapasitas 1.000 ml yang telah
disiapkan dan diberi label sesuai titik pengambilan. Selanjutnya, sampel disimpan
dalam cool box untuk menjaga kualitas dan kestabilan karakteristik air selama
transportasi. Sampel tersebut kemudian diuji di laboratorium untuk menentukan
konsentrasi Total Suspended Solid (TSS), dimana hasil uji laboratorium ini
digunakan sebagai data referensi (ground truth) yang krusial dalam proses kalibrasi

dan validasi model estimasi TSS berbasis citra Landsat &.

ORATORIUM KESEHATAN
SILAMPUNG
=

e
W

Gambar 4. Uji laboratorium sampel TSS

3.5 Tahapan Pengolahan Data

Proses pengolahan data terdiri dari beberapa tahapan. Berikut merupakan tahap —

tahap dalam proses pengolahan data:
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3.5.1 Pemotongan Citra

Pada tahap ini dilakukan pemotongan citra Landsat 8 hasil perekaman tahun 2025.
Pemotongan citra dilakukan dengan tujuan untuk memudahkan dalam proses
analisis citra dengan membatasi luasan sesuai dengan area yang akan dilakukan
penelitian. Software yang digunakan dalam pemotongan citra Landsat 8 adalah
perangkat lunak GIS. Pemotongan citra dilakukan dengan memilih ArchToolbox >
Raster > Raster Processing > Clip. Kemudian sesuaikan dengan lokasi penelitian
yaitu wilayah perairan Bendungan Way Rarem. Proses pemotongan citra dapat

dilihat seperti pada gambar.

W

A tooten

Gambar 5. Proses pemotongan citra

3.5.2 Pengolahan NDWI

Perhitungan NDWI digunakan untuk memisahkan bagian darat dan perairan.
Perhitungan ini juga digunakan untuk mendeteksi distribusi air permukaan. Pada
umumnya, daerah dengan nilai NDWI tinggi menunjukkan bahwa ada banyak
badan air di dalamnya. Nilai NDWI dibagi dengan rentang nilai -1 sampai dengan
1. Nilai NDWI lebih besar dari 0 menunjukkan bahwa daerah tersebut berupa
perairan dan nilai NDWI kurang dari 0 menunjukkan bahwa daerah tersebut adalah

daratan. Gambar di bawah ini menunjukkan langkah-langkah perhitungan NDWI.
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Gambar 6. Proses Perhitungan NDWI

3.5.3 Perhitungan Algoritma TSS

Tahap perhitungan data ini berfokus pada penentuan nilai konsentrasi Total
Suspended Solid (TSS) di area penelitian. Proses ini memanfaatkan data citra satelit
Landsat 8 sebagai sumber informasi utama, dipilih karena kemampuannya dalam
merekam pantulan spektral permukaan air yang sensitif terhadap material
tersuspensi. Pengolahan data dilakukan secara geospasial menggunakan perangkat

lunak GIS.

Penentuan nilai konsentrasi TSS dilakukan melalui penerapan tiga model algoritma
yang berbeda, yaitu algoritma TSS Laili, algoritma TSS Parwati, dan algoritma TSS
Budiman. Penerapan multi-algoritma ini bertujuan untuk membandingkan akurasi
dan validitas hasil di wilayah penelitian. Perhitungan nilai TSS berdasarkan
persamaan matematis dari masing-masing algoritma diimplementasikan melalui
fitur Raster Calculator pada perangkat lunak GIS. Fitur ini memungkinkan aplikasi
persamaan band-to-band secara efisien di seluruh piksel citra, yang menghasilkan

peta sebaran spasial konsentrasi TSS untuk setiap model yang diuji.
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3.5.4 Pembagian Kelas untuk TSS

Pembagian kelas pada data Total Suspended Solid (TSS) dilakukan sebagai tahap
lanjutan dalam pengolahan data untuk menyesuaikan nilai konsentrasi sedimen
tersuspensi dengan baku mutu kualitas air yang tercantum dalam Peraturan
Pemerintah Republik Indonesia Nomor 22 tentang Penyelenggaraan Perlindungan
dan Pengelolaan Lingkungan Hidup. Pada tahap ini, nilai TSS yang diperoleh dari
hasil ekstraksi data citra dikonversi ke dalam beberapa kelas kualitas berdasarkan

ambang batas baku mutu yang berlaku.

Proses pembagian kelas dilakukan menggunakan fitur reclassify pada perangkat
lunak perangkat lunak GIS, dimana setiap rentang nilai TSS diberikan kode kelas
dan simbolisasi yang seragam. Tahapan ini bertujuan untuk menyederhanakan
interpretasi kondisi kualitas perairan, mempermudah analisis spasial lanjutan, serta
mengidentifikasi area yang mengalami degradasi kualitas air berdasarkan tingkat
kekeruhannya. Hasil reklasifikasi ini menjadi dasar penting dalam evaluasi kondisi
perairan dan mendukung penyusunan rekomendasi pengelolaan lingkungan yang
sesuai standar nasional. Proses ini dilakukan dengan memilih ArchTollbox >

Spatial Analyst Tools > Reclass > Reclassify.

=

Gambar 10. Reclassify data TSS
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3.5.5 Uji Validasi Data

Analisis validasi data dilakukan untuk menilai tingkat ketelitian hasil estimasi
parameter kualitas air yang diperoleh dari interpretasi citra satelit terhadap data
hasil pengukuran lapangan. Proses validasi ini bertujuan untuk memastikan bahwa
nilai estimasi yang dihasilkan mampu merepresentasikan kondisi aktual perairan

secara objektif dan dapat dipertanggungjawabkan secara ilmiah.

Metode yang digunakan dalam proses validasi adalah Root Mean Square Error
(RMSE). RMSE dipilih karena mampu mengukur besarnya penyimpangan antara
nilai hasil estimasi dan nilai pengamatan lapangan secara kuantitatif, dengan satuan
yang sama seperti data aslinya. Perhitungan RMSE dilakukan berdasarkan selisih
antara nilai estimasi citra satelit dan nilai pengukuran lapangan, yang kemudian

dikuadratkan, dirata-ratakan, dan diambil akar kuadratnya.

Nilai RMSE yang diperoleh digunakan sebagai indikator tingkat akurasi model
estimasi yang diterapkan. Nilai RMSE yang semakin kecil menunjukkan tingkat
kesalahan prediksi yang rendah, sehingga model dianggap memiliki ketelitian yang
baik dalam menggambarkan kondisi kualitas air. Sebaliknya, nilai RMSE yang
tinggi mengindikasikan adanya perbedaan yang cukup besar antara hasil estimasi
dan data lapangan. Oleh karena itu, hasil analisis RMSE menjadi dasar dalam
menilai keandalan model yang digunakan untuk analisis kualitas air di Bendungan

Way Rarem.

3.5.6 Pengolahan NDCI

Perhitungan NDCI digunakan untuk mendeteksi dan mengestimasi konsentrasi
klorofil-a fitoplankton di perairan. Indeks ini memanfaatkan perbedaan
karakteristik reflektansi pada kanal merah (Red) dan inframerah dekat (NIR) pada
citra satelit. Secara khusus, NDCI dimanfaatkan untuk mendeteksi tingkat
produktivitas primer di perairan yang keruh (Case 2 Waters), yang berhubungan

langsung dengan kepadatan populasi alga. Nilai NDCI yang tinggi menunjukkan



31

adanya konsentrasi klorofil-a yang tinggi, mengindikasikan kondisi air yang
cenderung eutrofik atau kaya nutrisi, yang sangat mendukung pertumbuhan alga

dan vegetasi terapung seperti eceng gondok.

Nilai NDCI memiliki rentang teoritis antara —1 hingga 1, sama seperti indeks
perbedaan terdinormalisasi lainnya. Namun, dalam konteks perairan tropis yang
kaya nutrisi, nilai NDCI yang lebih tinggi (mendekati 1) menunjukkan dominasi
klorofil dan fitoplankton. Nilai rendah atau negatif seringkali menunjukkan
perairan jernih (oligotrof) atau kondisi di mana padatan tersuspensi non-klorofil
(seperti TSS) lebih dominan, meskipun umumnya nilai NDCI digunakan sebagai
input untuk model regresi. Gambar berikut menunjukkan tahapan perhitungan

NDCI yang dilakukan pada penelitian ini.

Gambar 11. Proses perhitungan nilai NDCI

3.5.7 Perhitungan Nilai Klorofil-a

Setelah mendapatkan nilai NDCI, langkah selanjutnya adalah mengestimasi
konsentrasi klorofil-a dalam air. Proses ini memerlukan model regresi empiris yang
dikembangkan dari data ground truth lapangan, tetapi pada proses ini penulis
mengadopsi dari model yang telah ada karena keterbatasan data lapangan. Dalam
penelitian ini, model eksponensial yang spesifik untuk perairan tropis digunakan,
dengan persamaan chl-a=15,60 (740NDCD — Dengan menggunakan Raster
Calculator di perangkat lunak GIS, nilai NDCI dari setiap piksel citra dimasukkan

ke dalam persamaan tersebut. Hasil akhirnya adalah peta tematik dimana setiap
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piksel merepresentasikan konsentrasi chl-a dalam satuan mikrogram per liter
(ug/L). Konsentrasi chl-a ini merupakan indikator langsung dari biomassa
fitoplankton, semakin tinggi nilainya, semakin tinggi pula tingkat produktivitas

primer dan potensi risiko eutrofikasi pada waduk.

feeeee rererereres
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Gambar 12. Proses perhitungan nilai klorofil-a

3.5.8 Pembagian Kelas untuk Klorofil-a

Setelah konsentrasi klorofil-a berhasil diestimasi dari nilai NDCI, nilai-nilai
tersebut dikelompokkan ke dalam empat kelas kualitas air untuk memetakan risiko
eutrofikasi secara spasial. Klasifikasi ini didasarkan pada ambang batas konsentrasi
dalam satuan (png/L) yang diadopsi dari standar penilaian tingkat kesuburan perairan
Trophic State Index (TSI). Kelas pertama, Kualitas Air Sangat Baik, ditetapkan
untuk konsentrasi chl-a < 7 pg/LL (mencakup kondisi oligotrof). Kelas kedua,
kualitas air baik, berada pada rentang 7 - 12 pg/L Selanjutnya, kelas kualitas air
sedang ditentukan pada rentang 12 - 40 ng/L, yang mengindikasikan kondisi eutrof,
dimana peningkatan pertumbuhan alga sudah terlihat. Terakhir, konsentrasi chl-a >
40 pg/L, dikategorikan sebagai kualitas air buruk (hipereutrof), yang
mencerminkan beban nutrisi yang sangat tinggi dan risiko blooming yang serius.
Klasifikasi ini memungkinkan visualisasi area-area rentan terhadap pencemaran

nutrisi di bendungan.
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Proses pembagian kelas dilakukan menggunakan fitur Reclassify pada perangkat
lunak Perangkat lunak GIS, dimana setiap rentang nilai klorofil-a diberikan kode
kelas dan simbolisasi yang seragam. Tahapan ini bertujuan untuk menyederhanakan
interpretasi status trofik perairan (oligotrof, mesotrof, eutrof, hipereutrof),
mempermudah analisis spasial lanjutan, serta mengidentifikasi area yang
mengalami eutrofikasi berdasarkan tingkat kepadatan fitoplankton. Proses ini
dilakukan dengan memilih ArcToolbox > Spatial Analyst Tools > Reclass >

Reclassify.

3.5.9 Uji Korelasi Nilai TSS dan Klorofil-a

Tahap selanjutnya adalah melakukan uji korelasi untuk mengidentifikasi dan
mengukur hubungan statistik antara dua parameter kualitas air yang telah diestimasi
menggunakan citra satelit, yaitu TSS dan konsentrasi klorofil-a. Kedua parameter
ini memiliki peran krusial dalam menentukan kondisi perairan, TSS menunjukkan
tingkat kekeruhan fisik, sedangkan klorofil-a menunjukkan tingkat kesuburan
biologis (eutrofikasi). Uji korelasi ini menggunakan korelasi Pearson, bertujuan
untuk menentukan seberapa erat dan dalam arah apa (positif atau negatif) kedua
variabel ini saling berkaitan. Hasil dari uji korelasi ini akan memberikan gambaran
penting mengenai proses dominan yang terjadi di perairan bendungan, misalnya
apakah tingginya kekeruhan TSS di suatu waktu juga diikuti oleh peningkatan

biomassa alga atau sebaliknya.

Uji korelasi antara nilai TSS dan klorofil-a dilakukan menggunakan perangkat
lunak statistik SPSS untuk menentukan kekuatan dan arah hubungan linier antar
kedua variabel. Tahapan dimulai dengan memasukkan data TSS dan klorofil-a yang
telah diekstraksi dari hasil pengolahan citra ke dalam dua kolom variabel numerik
pada Data View. Selanjutnya, proses analisis diakses melalui menu Analyze >
Correlate > Bivariate. Dalam jendela Bivariate Correlations, kedua variabel
dipindahkan ke kotak Variables, dan opsi Pearson dicentang sebagai koefisien
korelasi yang dipilih, ditkuti dengan pemilihan Two-tailed untuk uji signifikansi.

setelah dijalankan, SPSS akan menghasilkan tabel matriks Correlations. Hasil
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utama yang diinterpretasikan adalah koefisien korelasi Pearson (r), yang
menunjukkan kekuatan dan arah hubungan, serta nilai signifikansi (p-value), yang
menentukan apakah hubungan tersebut valid secara statistik pada tingkat

kepercayaan tertentu.
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Gambar 13. Proses uji korelasi konsentrasi TSS dan klorofil-a

Prosedur uji korelasi dimulai dengan memasukkan data TSS dan klorofil-a hasil
ekstraksi citra satelit ke dalam kolom variabel pada Data View SPSS. Selanjutnya,
analisis dilakukan melalui menu Analyze > Correlate > Bivariate, dimana kedua
variabel dipindahkan ke kotak Variables dengan mencentang opsi Pearson dan
memilih uji signifikansi 7Two-failed. Setelah perintah dijalankan, SPSS akan
menghasilkan tabel matriks korelasi yang menampilkan koefisien korelasi Pearson
(r) untuk menentukan kekuatan serta arah hubungan, serta nilai p-value untuk

menguji validitas hubungan tersebut secara statistik.



BAB 5 SIMPULAN DAN SARAN

5.1 Simpulan

Berdasarkan hasil penelitian Analisis Kualitas Air Berdasarkan Parameter Total

Suspended Solid dan Klorofil-a Menggunakan Citra Landsat 8 di Bendungan Way

Rarem, maka diperoleh kesimpulan:

1.

Distribusi spasial konsentrasi Total Suspended Solid (TSS) di Bendungan Way
Rarem pada tahun 2025 yang dimodelkan menunjukkan sebaran yang bervariasi
di seluruh badan air. Berdasarkan hasil pengolahan, konsentrasi TSS di
Bendungan Way Rarem memiliki rentang nilai antara 27,32 pg/L hingga 44,52
ug/L. Sedangkan distribusi nilai untuk klorofil-a berada pada rentang 2,92-
106,73 ng/L.

Hasil evaluasi terhadap tiga algoritma estimasi menunjukkan bahwa algoritma
budiman merupakan model terbaik untuk memetakan TSS di lokasi penelitian.
Hal ini didasarkan pada perhitungan nilai kesalahan terendah dengan nilai
RMSE sebesar 1,571 mg/l, yang menunjukkan akurasi lebih tinggi dibandingkan
dengan algoritma Laili dan algoritma Parwati.

Kondisi kualitas air di Bendungan Way Rarem pada tahun 2025 didominasi oleh
status Hipereutrofik dan Mesotrof, yang menunjukkan tingkat kesuburan
perairan dari sedang hingga sangat tinggi. Berdasarkan uji korelasi Pearson,
terdapat hubungan positif dan signifikan antara parameter TSS dan klorofil-a
dengan nilai r = 0,556. Hubungan ini menjelaskan bahwa konsentrasi material
tersuspensi (TSS) berkontribusi terhadap ketersediaan nutrien yang memicu
peningkatan klorofil-a, yang pada akhirnya menjadi faktor pendorong utama

terjadinya fenomena blooming eceng gondok di area bendungan.
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5.2 Saran

Berdasarkan hasil penelitian dan analisis yang telah dilakukan, maka dapat
diberikan beberapa saran yang dapat menjadi pertimbangan bagi beberapa pihak
terkait, yaitu:

1. Disarankan bagi peneliti selanjutnya untuk memperkuat validitas model estimasi
yang digunakan dengan melakukan pengambilan data lapangan (in-sifu) secara
lebih intensif, mencakup parameter seperti TSS dan klorofil-a. Selain itu,
penelitian selanjutnya sangat disarankan untuk fokus pada analisis karakteristik
Daerah Aliran Sungai (DAS) Bendungan Way Rarem, termasuk pemetaan
penggunaan lahan dan identifikasi tingkat erosi. Hal ini bertujuan untuk secara
spesifik menentukan sumber utama dari sedimen yang bertanggung jawab
membawa beban nutrisi tinggi ke perairan bendungan.

2. Berdasarkan temuan utama bahwa tingginya beban TSS adalah faktor kunci
hipereutrofikasi, Balai Besar Wilayah Sungai (BBWS) harus menjadikan
pengendalian erosi dan sedimentasi di wilayah DAS hulu sebagai program
konservasi prioritas utama. Selain itu, pemerintah perlu mengembangkan sistem
pemantauan kualitas air yang berkelanjutan berbasis remote sensing dan data
stasiun in-situ untuk menciptakan sistem peringatan dini eutrofikasi, yang
memungkinkan tindakan pencegahan cepat sebelum blooming eceng gondok
mencapai kondisi krisis. Pemerintah juga didorong untuk mengimplementasikan
program pengelolaan eceng gondok yang terintegrasi, yang tidak hanya berfokus
pada pembersihan, tetapi juga pada pemanfaatan biomassa untuk mengurangi
nutrisi yang terakumulasi.

3. Bagi masyarakat yang bermukim di sekitar DAS, didorong untuk berpartisipasi
aktif dalam upaya konservasi. Langkah ini termasuk edukasi dan praktik
penggunaan lahan yang berkelanjutan untuk meminimalkan erosi dan
penggunaan pupuk berlebihan yang menyebabkan run-off nutrisi ke bendungan.
Selain itu, partisipasi masyarakat lokal dalam kegiatan pembersihan eceng
gondok secara berkala sangat penting untuk menjaga agar blooming tidak meluas
dan mengganggu fungsi ekologis serta ekonomi bendungan. Komunitas lokal

juga diharapkan untuk mendukung dan mematuhi kebijakan yang dikeluarkan
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oleh pemerintah terkait tata kelola lahan di sekitar bendungan dan DAS agar

upaya konservasi dapat berjalan secara efektif, komprehensif, dan berkelanjutan.
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